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Preface

This user guide describes how to get started with the ATmega328P Xplained Mini evaluation kit. The
evaluation kit is a hardware platform to evaluate the ATmega328P microcontroller. The on-board mini
embedded debugger provides seamless integration with Atmel Studio. The kit provides access to the
features of the ATmega328P enabling easy integration of the device in a custom design.
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1. Introduction

1.1 Features
The ATmega328P Xplained Mini evaluation kit provides a development platform for the ATmega328P.

Key Features

• On-board debugger with full source-level debugging support in Atmel Studio
• Auto-ID for board identification in Atmel Studio
• Access to all signals on the target MCU
• One green mEDBG status LED
• One yellow user LED
• One mechanical user push button
• Virtual COM port (CDC)
• External target CLK 16 MHz at 5V, 8 MHz at 3.3V
• USB powered
• 3.3V regulator
• Arduino shield compatible footprints
• Target SPI bus header footprint
• Xplained Pro extension headers can easily be strapped in

1.2 Board Overview
A brief overview of the default kit configuration, headers, and connectors.
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Figure 1-1. ATmega328P Xplained Mini Headers and Connectors
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Table 1-1. Default Configurations

Function Default configuration Other settings

Kit power source (J300) 5.0V USB powered External input VIN (1)

Target power (J301) 5.0V USB powered 3.3V from on-board regulator (1)

ATmega328P clock 16 MHz mEDBG clock (2) Internal oscillator (3)

Info: 
Changing the default settings require modification of the kit using a soldering iron.

1. Details on how to change the power settings are described in Power Sources.
2. Details on the mEDBG clock are described in Xplained Mini Clock Output.
3. Debugging through debugWIRE may be disabled if the internal oscillator is used.
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2. Getting Started

2.1 Xplained Mini Quick Start
Steps to start exploring the Xplained Mini platform:

1. Download Atmel Studio.
2. Launch Atmel Studio.
3. Connect a USB cable (Standard-A to Micro-B or Micro-AB) between the PC and the USB port on

the kit.

When the Xplained Mini kit is connected to your computer for the first time, the operating system will
perform a driver software installation. The driver file supports both 32- and 64-bit versions of Microsoft®

Windows® XP, Windows Vista®, Windows 7, Windows 8, and Windows 10. The drivers for the kit are
included with the Atmel Studio.

Once the Xplained Mini board is powered the green status LED will blink and Atmel Studio will autodetect
which Xplained Mini board is connected. Atmel Studio will present relevant information like data sheets
and kit documentation. The ATmega328P device is programmed and debugged by the on-board Mini
Embedded Debugger and therefore no external programmer or debugger tool is required.

2.2 Design Documentation and Related Links
The most relevant documents and software for the evaluation kit are available here:

ATmega328P Xplained Mini website - Kit information, latest user guide, and design documentation.

ATmega328P Xplained Mini on Microchip Direct - Buy this kit on microchipDIRECT.

• Atmel Studio - Free IDE for the development of C/C++ and assembler code for microcontrollers.
• Xplained products - Xplained evaluation kits are a series of easy-to-use evaluation kits for

Microchip microcontrollers and other Microchip products.
– Xplained Nano - used for low pin-count devices and provides a minimalistic solution with

access to all I/O pins of the target microcontroller.
– Xplained Mini - used for medium pin-count devices and adds Arduino Uno compatible header

footprint and a prototyping area.
– Xplained Pro - used for medium to high pin-count devices that features advanced debugging

and standardized extensions for peripheral functions.

Note:  All the above kits have on-board programmers/debuggers, which creates a set of low-cost
boards for evaluation and demonstration of features and capabilities of different Microchip products.

• Atmel Spaces - Open Source projects for Xplained Mini.
• http://start.atmel.com/ - Atmel START is an online tool that helps the user to select and configure

software components and tailor your embedded application in a usable and optimized manner.

2.3 Programming and Debugging

2.3.1 Programming the Target Using mEDBG
Using the Embedded Debugger on the ATmega328P Xplained Mini board to program the ATmega328P.

1. Connect the Xplained Mini USB to the PC.
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2. Go to Atmel Studio: Click the Tools tab, select Device Programming, and select the connected
mEDBG as Tool with Device as ATmega328P and Interface to ISP, click Apply.

3. Select "Memories", locate the source .hex or .elf file, and click Program.

4. NOTE: If a previous debug session was not closed by selecting "Disable debugWIRE and Close" in
the Debug menu, the DWEN fuse will be enabled and the target will still be in debug mode, i.e. it
will not be possible to program the target using the ISP interface.

5. If the source file contains fuse settings, select "Production file" and upload the .elf file to program
the fuses.

6. Select "Fuses" to program the fuses manually. Set the fuse(s) and click "Program". Recommended
fuse settings:

 ATmega328P Xplained Mini

© 2017 Microchip Technology Inc.  User Guide DS50002659A-page 7



2.3.2 Debugging the Target Using mEDBG
Using the Embedded Debugger on the ATmega328P Xplained Mini board to debug the ATmega328P via
debugWIRE.

1. Start Atmel Studio.
2. Connect the Xplained Mini USB to the PC.
3. Open your project.
4. Click the "Project" tab and select the project "properties", click the "Tools" tab, and select mEDBG

as debugger and debugWIRE as interface.
5. Click the "Debug" tab and select "Start Debugging and Break".
6. Atmel Studio will display an error message if the DWEN fuse in the ATmega328P is not enabled,

click YES to make Studio set the fuse using the ISP interface.

7. A debug session is started with a break in main, the debugging can start.
8. To exit debug mode, select "Disable debugWIRE and Close" in the Debug tab. This will disable the

DWEN fuse.

 ATmega328P Xplained Mini
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Info: 
If debug mode is not exited by selecting "Disable debugWIRE and Close" in the Debug menu,
the DWEN fuse will be enabled and the target will still be in debug mode, i.e. it will not be
possible to program the target using ISP.

If any other CPU CLK than the external CLK supplied by the mEDBG is used, the debugWIRE
is not guaranteed to work.

Applying a signal to J202/RESET (the RESET_SENSE signal) while debugging may result in
unexpected behavior. This signal is NOT available during a debugging session because the
RESET line is actively used by the debugWIRE interface.

2.3.3 Programming the Target Using an External Programmer
How to program the target ATmega328P using the AVR® JTAGICE mkII, JTAGICE3, Atmel-ICE, or other
programmers.

1. Connect the External Programmer USB to the PC.
2. Connect the External Programmer to the ATmega328P Xplained Mini board ISP connector.
3. Go to Atmel Studio: Click the Tools tab, select Device Programming, and select the External

Programmer connected as Tool with Device as ATmega328P and Interface to ISP, click Apply.
4. Select "Memories", locate the source .hex or .elf file, and click Program.

2.3.4 Programming the ATmega32U4 Using an External Programmer
How to program the ATmega32U4 using the AVR JTAGICE mkII, JTAGICE3, Atmel-ICE, or other
programmers.

1. Connect the External Programmer USB to the PC.
2. Connect the External Programmer to the ATmega328P Xplained Mini board JTAG connector.
3. Go to Atmel Studio: Click the Tools tab, select Device Programming, and select the connected

mEDBG as Tool with Device as ATmega32U4 and Interface to JTAG, click Apply.
4. Select "Memories", locate the source .hex or .elf file, and click Program.

5. Select "Fuses" to program the fuses manually. Set the fuse(s) and click "Program". Recommended
fuse settings:
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Warning:  Changing the firmware in the ATmega32U4 will remove the programming and
debugging capabilities of the mEDBG. If the EEPROM is altered the mEDBG may not be
recognized by Atmel Studio anymore.

2.3.5 Programming the ATmega32U4 Using a Bootloader
This section describes how to use the bootloader to program the ATmega32U4.

1. Launch Atmel Studio.
2. Short strap J102.
3. Open the programming dialog, select the bootloader in the tool menu.
4. Connect the ATmega328P Xplained Mini board USB connector to the PC.
5. Select Device = ATmega32U4 (Device - Select).
6. Select USB communication (Ctrl+U).
7. Select the memory area to program (use the toggle memory button).
8. Select Load Hex file (Ctrl+L).
9. Select Programming Options.
10. Click "Run", observe the status in the status field.

Warning:  Changing the firmware in the ATmega32U4 will remove the programming and
debugging capabilities of the mEDBG. If the EEPROM is altered the mEDBG may not be
recognized by Atmel Studio anymore.
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3. Xplained Mini
Xplained Mini is an evaluation platform that provides a set of small boards with access to all
microcontroller I/Os. The platform consists of a series of low-pin-count Microcontroller (MCU) boards,
which are integrated with Atmel Studio to present relevant user guides, application notes, datasheets,
and example code. The platform also features a Virtual COM port for serial communication to a host PC.

3.1 Mini Embedded Debugger
The ATmega328P Xplained Mini contains the Mini Embedded Debugger (mEDBG) for on-board
programming and debugging. The mEDBG is a composite USB device of two interfaces; a debugger and
a Virtual COM Port.

Together with Atmel Studio, the mEDBG debugger interface can program and debug the ATmega328P.
On ATmega328P Xplained Mini, the ISP/dW interface is connected between the mEDBG and the
ATmega328P.

The Virtual COM Port is connected to a UART on the ATmega328P and provides an easy way to
communicate with the target application through the terminal software. It offers variable baud rate, parity,
and stop bit settings.
Note:  The settings on the ATmega328P must match the settings given in the terminal software.

Info:  The virtual COM port in the mEDBG requires the terminal software to set the data
terminal ready (DTR) signal to enable the UART pins connected to the ATmega328P. If the DTR
signal is not enabled the UART pins on the mEDBG are kept in high-z (tri-state) rendering the
COM port unusable. The DTR signal is automatically set by some terminal software, but it may
have to be manually enabled in your terminal.

The mEDBG controls one status LED on the ATmega328P Xplained Mini. The table below shows how the
LED is controlled in different operation modes.

Table 3-1. mEDBG LED Control

Operation mode Status LED

Power up LED is briefly lit

Normal operation LED is not lit

Programming Activity indicator; the LED flashes when
programming/debugging with the mEDBG

3.1.1 Xplained Mini Clock Output
The mEDBG outputs its CPU clock on a pin. This clock pin is connected to the ATmega328P clock input
and is used to have a synchronous clock with the mEDBG to enable debugging through debugWIRE.

To disconnect the external clock to the ATmega328P a 0Ω resistor or strap has to be removed from the
footprint, as shown in the figure below (R109).
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Figure 3-1. External Clock Footprint

The mEDBG CPU clock frequency depends on the selected voltage, see the table below.

Table 3-2. CPU Clock vs. Voltage

Target voltage mEDBG CPU clock

3.3V 8 MHz

5.0V 16 MHz

3.2 mEDBG Configuration
The operation of the mEDBG can be configured by writing registers in the mEDBG. No configuration is
required for default operation.

3.2.1 mEDBG Low Power Modes
There are two modes that enable the mEDBG to save power when connected to an external power
source.

EOF mode, where the mEDBG is disabled. When enabled the ATmega32U4 will enter sleep mode if the
USB does not enumerate within 5 seconds of power-up. In this mode, the external clock is not available
to the target MCU.

LOWP mode, where the mEDBG is set to run at 1 MHz. Saving power while maintaining the USB
connection for the COM port. The external clock will be 1 MHz.

Table 3-3. Low Power Modes Operation

Mode External CLK COM port ISP/dW program ISP/dW debug

EOF disabled disabled disabled disabled

LOWP forced 1 MHz enabled useless useless

Factory settings enabled enabled enabled enabled

3.2.2 mEDBG Fuse Filter
The mEDBG does not initially allow users to program all fuses of the target device through Atmel Studio,
as a filter is implemented to protect certain fuses. The protected fuses are different for every product
using the mEDBG and are typically clock related fuses that could be set to invalid configurations.

The fuse protection can be disabled by writing the FUSE bit to 0.
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Info:  The fuse filter prevents users from changing critical fuses using Atmel Studio; however, it
does not prevent users from setting fuses freely using the command line interface atprogram
bundled with Atmel Studio.

3.2.3 mEDBG Command Line Interface
The configuration of the mEDBG can be changed using a simple command line interface available on 
Atmel Spaces Releases (mEDBG_script.zip).

The CLI is written for Python® 2.7 and may work on other Python 2.x versions. Python can be
downloaded from Python.

The CMSIS-DAP commands used by the CLI are not supported in early mEDBG firmware versions. To
upgrade the firmware, download the latest version of Atmel Studio and connect to the mEDBG with the
programming dialog.

The register definitions are available in the following sections.

Related Links
SUFFER

 ATmega328P Xplained Mini
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3.2.4 Super User Fantastic Feature Enable Register

The Super User Fantastic Feature Enable Register allows the user to modify the behavior of the mEDBG.

Name:  SUFFER
Offset:  0x0120
Reset:  0xFF
Property:
 

N/A

Bit 7 6 5 4 3 2 1 0  
      EOF LOWP FUSE  

Access R/W R/W R/W  
Reset 1 1 1  

Bit 2 – EOF: Extended Off
Writing the EOF bit to 1 sets default operation. Writing the EOF bit to 0 enables the extended off power
mode. If no USB enumeration is successful within five seconds of power up, the mEDBG enters deep
sleep.

Bit 1 – LOWP: Low Power
Writing the LOWP bit to 1 sets the system clock to its default value. Writing the LOWP bit to 0 enables
low power mode. The mEDBG is set to run at 1 MHz, which decreases the power usage.

Bit 0 – FUSE: FUSE Protection
Writing the FUSE bit to 1 enables fuse protection when using Atmel Studio. The fuse protection prevents
modification of specific fuses in the ATmega328P target device that could make the mEDBG on the
ATmega328P Xplained Mini not usable. Writing the FUSE bit to 0 removes all protection of fuses in the
ATmega328P target device.

Warning:  Writing the FUSE bit to 0 enables modification of all fuses in the ATmega328P.
Setting wrong fuse settings may render the mEDBG not usable on the ATmega328P Xplained
Mini. As an example; if an invalid clock setting is set, a recovery may require an external
debugger.

3.3 mEDBG Firmware Upgrade and Manual Bootloader Entry
The mEDBG firmware is updated through the programming dialog in Atmel Studio.

If you are unable to upgrade the mEDBG firmware on your ATmega328P Xplained Mini, you can try the
command line utility atfw.exe provided with the Atmel Studio. atfw.exe is located in the atbackend folder in
your Atmel Studio install location.

To manually upgrade the firmware, run the following command:

atfw.exe -t medbg -a ..\tools\ mEDBG\medbg_fw.zip

If atfw.exe is unable to find the mEDBG it may be required to force the ATmega32U4 (mEDBG) to enter
its bootloader. To force the bootloader entry, short-circuit the BOOT pads (J102) and toggle power to the
ATmega328P Xplained Mini board. Run the atfw command above. When the firmware is upgraded,
remove the power from the kit and remove the short-circuit of J102.
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Figure 3-2. Force Boot Jumper
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4. Hardware User Guide
The following sections describe the implementation of the relevant peripherals, headers, and connectors
on the ATmega328P Xplained Mini and their connections to the ATmega328P. The tables of connections
in the sections below also describe which signals are shared between the headers and on-board
functionality.

The figure below shows the assembly drawing of the ATmega328P Xplained Mini to help identification of
components.

 ATmega328P Xplained Mini
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Figure 4-1. ATmega328P Xplained Mini Assembly Drawing

4.1 Power Sources
The ATmega328P Xplained Mini kit can be powered by a USB or an external voltage input VIN. The
default power source is 5.0V from a USB. The USB port is protected with a 500 mA PTC resettable fuse.

The ATmega328P is powered from the 5.0V USB voltage by default.

The figure below shows the possible kit power supply connections.
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Figure 4-2. Power Supply Block Diagram
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The input voltage select jumper (J300, 3-pin header footprint) can be soldered in to select between power
from the USB port or from the VIN pin on the Arduino power header footprint. By default, the selector is
bypassed with a 0Ω resistor (R300) to connect the USB voltage to the on-board 3.3V/150 mA regulator
and target voltage select header.

The target voltage select jumper (J301, 3-pin header footprint) can be soldered in to select between the
on-board 3.3V regulator or the voltage from the input voltage select jumper (J300). The selector is
bypassed with a 0Ω resistor (R301) to connect the kit input voltage to the ATmega328P and mEDBG.

Important:  If the target voltage and input voltage select headers are soldered in and used with
a jumper, the bypass 0Ω resistors have to be removed to avoid contention.

4.2 Board Assembly
The Xplained Mini board can easily be assembled into a product prototype for software development and
hardware verification. All signals of the ATmega328P are available in the Xplained Mini board connector
grid, enabling easy connection of external sensors and output devices in order to prototype the customer
specific application.

4.2.1 Connecting an Arduino Shield
Arduino® shields can be mounted in the marked positions (J200, J201, J202, J203, and J204).

Warning:  The ATmega328P Xplained Mini connects VCC_TARGET to the Arduino SPI
connector, while all Arduino boards connect VCC_P5V0 to the same pin. The VCC_TARGET
may be either 3.3V or 5.0V depending on the configuration of the kit if the kit is configured for
3.3V operation. Connecting an Arduino shield may damage the board permanently. It is not
recommended to solder the SPI connector when using Arduino shields if not strictly necessary.
If the connector is required it is recommended to remove pin two from the SPI connector.

4.3 Target Headers and Connectors

4.3.1 Target Digital I/O
The J200 and J201 headers provide access to the ATmega328P digital I/O pins.
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Table 4-1. J200 Digital I/O High Byte Header

J200 pin ATmega328P pin Function

1 PB0

2 PB1

3 PB2 SS, SPI Bus Master Slave select

4 PB3 MOSI, SPI Bus Master Output/Slave Input

5 PB4 MISO, SPI Bus Master Input/Slave Output

6 PB5 SCK, SPI Bus Master Clock Input

7 GND

8 AREF

9 PC4 SDA, 2-wire Serial Bus Data Input/Output Line. Shared with
ADC4.

10 PC5 SCL, 2-wire Serial Bus Clock Line. Shared with ADC5.

Table 4-2. J201 Digital I/O High Low Header

J201 pin ATmega328P pin Function

1 PD0 RXD (ATmega328P USART Input Pin)

2 PD1 TXD (ATmega328P USART Output Pin)

3 PD2

4 PD3

5 PD4

6 PD5

7 PD6

8 PD7

4.3.2 Board Power Header
The J202 header enables connection to the ATmega328P Xplained Mini power system.

Table 4-3. J202 Power Header

J202 pin Signal Description

1 NC

2 VCC_TARGET The power source selected for the target (selected by J301)

3 RESET_SENSE This is a RESET signal monitored by the mEDBG, if pulled low the
target RESET line will be pulled low by the mEDBG. The ATmega32U4
internal pull-up is enabled. This signal is not available during debugging.

4 VCC_P3V3 The 3.3V regulator output

5 VCC_P5V0 The selected power source (VIN or VBUS selected by J300)
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J202 pin Signal Description

6 GND

7 GND

8 VCC_VIN The external power source connection

4.3.3 Target Analog I/O
The ATmega328P ADC input pins are available in the J203 header.

AREF is available in J200 pin 8.

Table 4-4. J203 Analog Header

J203 pin ATmega328P pin Function

1 PC0 ADC Input Channel 0

2 PC1 ADC Input Channel 1

3 PC2 ADC Input Channel 2

4 PC3 ADC Input Channel 3

5 PC4 ADC Input Channel 4

6 PC5 ADC Input Channel 5

4.3.4 Target Programming
The J204 header enable direct connection to the ISP bus with an external programmer for programming
of the ATmega328P.

Table 4-5. ISP Header

J204 pin ATmega328P pin Function

1 PB4 MISO

2 VCC target

3 PB5 SCK

4 PB3 MOSI

5 PC6 RESET

6 GND

4.3.5 Target Additional I/O
Signals not available in any of the headers or connectors are available in column 5 of the grid.

Table 4-6. Additional I/O

ATmega328P pin Grid position

ADC6 H5

ADC7 G5
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4.4 Target Peripherals
The ATmega328P Xplained Mini has one LED and one push button.

Figure 4-3. Peripherals

4.4.1 Push Button
A general purpose push button, SW200, is connected to PB7.

Figure 4-4. Push Button
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4.4.2 User LED
There is one yellow LED, D200, available for use by the application SW.

The LED is connected to ATmega328P, pin 17 - PB5. The SCK signal from the mEDBG is in tri-state
when not used.
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Figure 4-5. User LED
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4.5 mEDBG
The ATmega328P Xplained Mini board has an embedded debugger/programmer enabling debugging and
programming of the ATmega328P without any additional external equipment.

4.5.1 mEDBG COM Port Connection
The mEDBG provides a CDC COM port connection when connected to a USB host device.

The mEDBG (ATmega32U4) USART is used for communication with the CDC COM port. The USART
TX/RX signals are available on the J104 header and are also connected to the ATmega328P via 0Ω
resistors enabling easy disconnect from the ATmega328P, if needed. The RX/TX silk screen notation next
to J104 refers to the RX and TX pins of the mEDBG (ATmega32U4).

Table 4-7. J104 USART Header

J104 pin ATmega32U4 ATmega328P Function

1 - USART TxD PD3 PD0 (RxD) TxD out from ATmega32U4

2 - USART RxD PD2 PD1 (TxD) RxD in to ATmega32U4

4.5.2 mEDBG JTAG Interface
The mEDBG (ATmega32U4) JTAG interface is available for programming and debugging of the
ATmega32U4 on the 50-mil header in the upper right corner of the kit.

Table 4-8. J100 JTAG Header

J100 pin Signal name Description

1 TCK

2 GND

3 TDO
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J100 pin Signal name Description

4 VCC_BOARD ATmega32U4 VCC (J301 pin 2)

5 TMS

6 RESET Connected to ATmega32U4 only

7 NC

8 NC

9 TDI

10 GND

4.6 Extension Header Area
The marked area on the grid I7 to R8 can be used for strapping in an Xplained Pro extension header or a
10-pin legacy Xplained/RZ600 header.

Figure 4-6. Extension Header Area

The SPI bus signals are available close to the header at row J and K, enabling easy connection to header
pin 15 to 18.

Using pin 11 to 20 enables connection of the 10-pin legacy header used on the RZ600 wireless modules
and the 10-pin Xplained sensor modules.

The general bus connections for an Xplained Pro Extension board are indicated in the table below.
Detailed wiring can be found in the selected extension board documentation.

Table 4-9. Extension Header Typical Signals

Pin Signal name Signal description

1 ID Communication line to the ID chip on the Xplained extension board

2 GND Ground

3 ADC(+) Analog to digital converter, alternatively positive part of differential ADC

4 ADC(-) Analog to digital converter, alternatively negative part of differential ADC

5 GPIO1 General purpose I/O
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Pin Signal name Signal description

6 GPIO2 General purpose I/O

7 PWM(+) Pulse width modulation, alternatively positive part of differential PWM

8 PWM(-) Pulse width modulation, alternatively negative part of differential PWM

9 IRQ/GPIO Interrupt request line and/or general purpose I/O

10 SPI_SS_B/
GPIO

Slave B select for SPI and/or general purpose I/O

11 I2C_SDA Data line for I2C interface

12 I2C_SCL Clock line for I2C interface

13 UART_RX Receiver line of ATmega328P USART

14 UART_TX Transmitter line of ATmega328P USART

15 SPI_SS_A Slave A select for SPI

16 SPI_MOSI Master out slave in line of serial peripheral interface

17 SPI_MISO Master in slave out line of serial peripheral interface

18 SPI_SCK Clock for serial peripheral interface

19 GND Ground

20 VCC Power for extension board

4.7 Factory Programmed
The ATmega328P is preprogrammed with a demo program; ReMorse.

The source code is available in Atmel Spaces.

When the CDC COM port is connected to a terminal window (9600 8N1), the text you write will be
transmitted via the LED in Morse code. Any Morse code transmitted by using the button will be displayed
as text in the terminal window.

The ATmega32U4 is preprogrammed with the mEDBG firmware.
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5. Hardware Revision History and Known Issues
This user guide provides the latest available revision of the kit. This chapter contains information about
known issues, a revision history of older revisions, and how older revisions differ from the latest revision.

5.1 Identifying Product ID and Revision
The revision and product identifier of Xplained Mini boards can be found in two ways; either through
Atmel Studio or by looking at the sticker on the bottom side of the PCB.

By connecting an Xplained Mini board to a computer with Atmel Studio running, an information window
will pop up. The first six digits of the serial number, which is listed under kit details, contain the product
identifier and revision.

The same information can be found on the sticker on the bottom side of the PCB. Most kits will print the
identifier and revision in plain text as A09-nnnn\rr, where nnnn is the identifier and rr is the revision.
Boards with limited space have a sticker with only a data matrix code, which contains a serial number
string.

The serial number string has the following format:

"nnnnrrssssssssss"

n = product identifier

r = revision

s = serial number

The product identifier for ATmega328P Xplained Mini is A09-2323.

5.2 Revision 4
Revision 4 is the initial released revision, and there are no known issues.
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6. Document Revision History
Document revision Date Comment

A 09/2017 Converted to Microchip format and replaced the Atmel document
number 42287C.

Restructured the user guide. Added the Hardware Revision History and
Known Issues chapter.

42287C 08/2015 Updated version

42287B 10/2014 Updated version

42287A 05/2014 Initial document release
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The Microchip Web Site

Microchip provides online support via our web site at http://www.microchip.com/. This web site is used as
a means to make files and information easily available to customers. Accessible by using your favorite
Internet browser, the web site contains the following information:

• Product Support – Data sheets and errata, application notes and sample programs, design
resources, user’s guides and hardware support documents, latest software releases and archived
software

• General Technical Support – Frequently Asked Questions (FAQ), technical support requests,
online discussion groups, Microchip consultant program member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip press releases,
listing of seminars and events, listings of Microchip sales offices, distributors and factory
representatives

Customer Change Notification Service

Microchip’s customer notification service helps keep customers current on Microchip products.
Subscribers will receive e-mail notification whenever there are changes, updates, revisions or errata
related to a specified product family or development tool of interest.

To register, access the Microchip web site at http://www.microchip.com/. Under “Support”, click on
“Customer Change Notification” and follow the registration instructions.

Customer Support

Users of Microchip products can receive assistance through several channels:

• Distributor or Representative
• Local Sales Office
• Field Application Engineer (FAE)
• Technical Support

Customers should contact their distributor, representative or Field Application Engineer (FAE) for support.
Local sales offices are also available to help customers. A listing of sales offices and locations is included
in the back of this document.

Technical support is available through the web site at: http://www.microchip.com/support

Microchip Devices Code Protection Feature

Note the following details of the code protection feature on Microchip devices:

• Microchip products meet the specification contained in their particular Microchip Data Sheet.
• Microchip believes that its family of products is one of the most secure families of its kind on the

market today, when used in the intended manner and under normal conditions.
• There are dishonest and possibly illegal methods used to breach the code protection feature. All of

these methods, to our knowledge, require using the Microchip products in a manner outside the
operating specifications contained in Microchip’s Data Sheets. Most likely, the person doing so is
engaged in theft of intellectual property.

• Microchip is willing to work with the customer who is concerned about the integrity of their code.
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• Neither Microchip nor any other semiconductor manufacturer can guarantee the security of their
code. Code protection does not mean that we are guaranteeing the product as “unbreakable.”

Code protection is constantly evolving. We at Microchip are committed to continuously improving the
code protection features of our products. Attempts to break Microchip’s code protection feature may be a
violation of the Digital Millennium Copyright Act. If such acts allow unauthorized access to your software
or other copyrighted work, you may have a right to sue for relief under that Act.

Legal Notice
Information contained in this publication regarding device applications and the like is provided only for
your convenience and may be superseded by updates. It is your responsibility to ensure that your
application meets with your specifications. MICROCHIP MAKES NO REPRESENTATIONS OR
WARRANTIES OF ANY KIND WHETHER EXPRESS OR IMPLIED, WRITTEN OR ORAL, STATUTORY
OR OTHERWISE, RELATED TO THE INFORMATION, INCLUDING BUT NOT LIMITED TO ITS
CONDITION, QUALITY, PERFORMANCE, MERCHANTABILITY OR FITNESS FOR PURPOSE.
Microchip disclaims all liability arising from this information and its use. Use of Microchip devices in life
support and/or safety applications is entirely at the buyer’s risk, and the buyer agrees to defend,
indemnify and hold harmless Microchip from any and all damages, claims, suits, or expenses resulting
from such use. No licenses are conveyed, implicitly or otherwise, under any Microchip intellectual
property rights unless otherwise stated.

Trademarks
The Microchip name and logo, the Microchip logo, AnyRate, AVR, AVR logo, AVR Freaks, BeaconThings,
BitCloud, CryptoMemory, CryptoRF, dsPIC, FlashFlex, flexPWR, Heldo, JukeBlox, KeeLoq, KeeLoq logo,
Kleer, LANCheck, LINK MD, maXStylus, maXTouch, MediaLB, megaAVR, MOST, MOST logo, MPLAB,
OptoLyzer, PIC, picoPower, PICSTART, PIC32 logo, Prochip Designer, QTouch, RightTouch, SAM-BA,
SpyNIC, SST, SST Logo, SuperFlash, tinyAVR, UNI/O, and XMEGA are registered trademarks of
Microchip Technology Incorporated in the U.S.A. and other countries.

ClockWorks, The Embedded Control Solutions Company, EtherSynch, Hyper Speed Control, HyperLight
Load, IntelliMOS, mTouch, Precision Edge, and Quiet-Wire are registered trademarks of Microchip
Technology Incorporated in the U.S.A.

Adjacent Key Suppression, AKS, Analog-for-the-Digital Age, Any Capacitor, AnyIn, AnyOut, BodyCom,
chipKIT, chipKIT logo, CodeGuard, CryptoAuthentication, CryptoCompanion, CryptoController,
dsPICDEM, dsPICDEM.net, Dynamic Average Matching, DAM, ECAN, EtherGREEN, In-Circuit Serial
Programming, ICSP, Inter-Chip Connectivity, JitterBlocker, KleerNet, KleerNet logo, Mindi, MiWi,
motorBench, MPASM, MPF, MPLAB Certified logo, MPLIB, MPLINK, MultiTRAK, NetDetach, Omniscient
Code Generation, PICDEM, PICDEM.net, PICkit, PICtail, PureSilicon, QMatrix, RightTouch logo, REAL
ICE, Ripple Blocker, SAM-ICE, Serial Quad I/O, SMART-I.S., SQI, SuperSwitcher, SuperSwitcher II, Total
Endurance, TSHARC, USBCheck, VariSense, ViewSpan, WiperLock, Wireless DNA, and ZENA are
trademarks of Microchip Technology Incorporated in the U.S.A. and other countries.

SQTP is a service mark of Microchip Technology Incorporated in the U.S.A.

Silicon Storage Technology is a registered trademark of Microchip Technology Inc. in other countries.

GestIC is a registered trademark of Microchip Technology Germany II GmbH & Co. KG, a subsidiary of
Microchip Technology Inc., in other countries.

All other trademarks mentioned herein are property of their respective companies.
© 2017, Microchip Technology Incorporated, Printed in the U.S.A., All Rights Reserved.
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ISBN: 978-1-5224-2082-8

Quality Management System Certified by DNV

ISO/TS 16949
Microchip received ISO/TS-16949:2009 certification for its worldwide headquarters, design and wafer
fabrication facilities in Chandler and Tempe, Arizona; Gresham, Oregon and design centers in California
and India. The Company’s quality system processes and procedures are for its PIC® MCUs and dsPIC®

DSCs, KEELOQ® code hopping devices, Serial EEPROMs, microperipherals, nonvolatile memory and
analog products. In addition, Microchip’s quality system for the design and manufacture of development
systems is ISO 9001:2000 certified.
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